Chapter 220

Group-Sequential Tests for Two Proportions

Introduction

Clinical trials are longitudinal. They accumulate data sequentially through time. The participants cannot be enrolled and randomized on the same day. Instead, they are enrolled as they enter the study. It may take several years to enroll enough patients to meet sample size requirements. Because clinical trials are long term studies, it is in the interest of both the participants and the researchers to monitor the accumulating information for early convincing evidence of either harm or benefit. This permits early termination of the trial.

Group sequential methods allow statistical tests to be performed on accumulating data while a phase III clinical trial is ongoing. Statistical theory and practical experience with these designs have shown that making four or five interim analyses is almost as effective in detecting large differences between treatment groups as performing a new analysis after each new data value. Besides saving time and resources, such a strategy can reduce the experimental subject’s exposure to an inferior treatment and make superior treatments available sooner.

When repeated significance testing occurs on the same data, adjustments have to be made to the hypothesis testing procedure to maintain overall significance and power levels. The landmark paper of Lan & DeMets (1983) provided the theory behind the alpha spending function approach to group sequential testing. This paper built upon the earlier work of Armitage, McPherson, & Rowe (1969), Pocock (1977), and O’Brien & Fleming (1979). PASS implements the methods given in Reboussin, DeMets, Kim, & Lan (1992) to calculate the power and sample sizes of various group sequential designs.

This module calculates sample size and power for group sequential designs used to compare two group proportions. Other modules perform similar analyses for the comparison of means and survival functions. The program allows you to vary the number and times of interim tests, the type of alpha spending function, and the test boundaries. It also gives you complete flexibility in solving for power, significance level, sample size, or effect size. The results are displayed in both numeric reports and informative graphics.

Technical Details

Suppose the means of two samples of $N1$ and $N2$ individuals will be compared at various stages of a trial using the $z_k$ statistic:

$$z_k = \frac{\hat{p}_{1k} - \hat{p}_{2k}}{\sqrt{\hat{p}_{1k}(1-\hat{p}_{1k}) + \hat{p}_{2k}(1-\hat{p}_{2k})}}$$
The subscript $k$ indicates that the computations use all data that are available at the time of the $k^{th}$ interim analysis or $k^{th}$ look ($k$ goes from 1 to $K$). This formula computes the standard $z$-test that is assumed to be normally distributed.

**Spending Functions**

Lan and DeMets (1983) introduced alpha spending functions, $\alpha(\tau)$, that determine a set of boundaries $b_1, b_2, \ldots, b_K$ for the sequence of test statistics $z_1, z_2, \ldots, z_K$. These boundaries are the critical values of the sequential hypothesis tests. That is, after each interim test, the trial is continued as long as $|z_k| < b_k$. When $|z_k| \geq b_k$, the hypothesis of equal means is rejected and the trial is stopped early.

The time argument $\tau$ either represents the proportion of elapsed time to the maximum duration of the trial or the proportion of the sample that has been collected. When elapsed time is being used it is referred to as calendar time. When time is measured in terms of the sample, it is referred to as information time. Since it is a proportion, $\tau$ can only vary between zero and one.

Alpha spending functions have the characteristics:

$$\alpha(0) = 0$$

$$\alpha(1) = \alpha$$

The last characteristic guarantees a fixed $\alpha$ level when the trial is complete. That is,

$$\Pr(|z| \geq b_1 \text{ or } |z_2| \geq b_2 \text{ or } \cdots \text{ or } |z_K| \geq b_K) = \alpha(\tau)$$

This methodology is very flexible since neither the times nor the number of analyses must be specified in advance. Only the functional form of $\alpha(\tau)$ must be specified.

**PASS** provides five popular spending functions plus the ability to enter and analyze your own boundaries. These are calculated as follows:

1. **O’Brien-Fleming**

   $$2 - 2\Phi\left(\frac{Z_{\alpha/2}}{\sqrt{\tau}}\right)$$

   ![O'Brien-Fleming Boundaries with Alpha = 0.05](image)
2. **Pocock**  \[ \alpha \ln(1 + (e - 1)\tau) \]

3. **Alpha * time**  \[ \alpha \tau \]

4. **Alpha * time^1.5**  \[ \alpha \tau^{3/2} \]
5. **Alpha * time^2**  \( \alpha t^2 \)

6. **User Supplied**

A custom set of boundaries may be entered.

The O'Brien-Fleming boundaries are commonly used because they do not significantly increase the overall sample size and because they are conservative early in the trial. Conservative in the sense that the proportions must be extremely different before statistical significance is indicated. The Pocock boundaries are nearly equal for all times. The Alpha*t boundaries use equal amounts of alpha when the looks are equally spaced. You can enter your own set of boundaries using the User Supplied option.

### Theory

A detailed account of the methodology is contained in Lan & DeMets (1983), DeMets & Lan (1984), Lan & Zucker (1993), and DeMets & Lan (1994). The theoretical basis of the method will be presented here.

Group sequential procedures for interim analysis are based on their equivalence to discrete boundary crossing of a Brownian motion process with drift parameter \( \theta \). The test statistics \( z_k \) follow the multivariate normal distribution with means \( \theta \sqrt{\tau_k} \) and, for \( j \leq k \), covariances \( \sqrt{\tau_k / \tau_j} \). The drift parameter is related to the parameters of the z-test through the equation

\[
\theta = \frac{p_1 - p_2}{\sqrt{\frac{p(1-p)}{N_1} + \frac{\bar{p}(1-\bar{p})}{N_2}}}
\]

where

\[
\bar{p} = \frac{N_1 p_1 + N_2 p_2}{N_1 + N_2}
\]

Hence, the algorithm is as follows:

1. Compute boundary values based on a specified spending function and alpha value.
2. Calculate the drift parameter based on those boundary values and a specified power value.
3. Use the drift parameter and the above equation to calculate the appropriate sample size.
Procedure Tabs
This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with the z-test such as the proportions, sample sizes, alpha, and beta.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are $P_1$, $P_2$, Alpha, Power, Sample Size ($N_1$) or Sample Size ($N_2$). Under most situations, you will select either Power or Sample Size ($N_1$).

Select Sample Size ($N_1$) when you want to calculate the sample size needed to achieve a given power and alpha level.

Select Power when you want to calculate the power of an experiment.

Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal proportions when in fact they are different.

Values must be between zero and one. Historically, the value of 0.80 ($\beta = 0.20$) was used for power. Now, 0.90 ($\beta = 0.10$) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. For this procedure, a type-I error occurs when you reject the null hypothesis of equal proportions when in fact they are equal.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on N1 or N2 or both.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter N1, solve for N2**
  Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

- **Enter N2, solve for N1**
  Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

- **Enter R = N2/N1, solve for N1 and N2**
  For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2, with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
  \[ N2 = R \times N1. \]

- **Enter percentage in Group 1, solve for N1 and N2**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed N1 and N2 with this percentage to obtain the desired power.

**N1 (Sample Size, Group 1)**
*This option is displayed if Group Allocation = “Enter N1, solve for N2”*

N1 is the number of items or individuals sampled from the Group 1 population.

N1 must be ≥ 2. You can enter a single value or a series of values.

**N2 (Sample Size, Group 2)**
*This option is displayed if Group Allocation = “Enter N2, solve for N1”*

N2 is the number of items or individuals sampled from the Group 2 population.

N2 must be ≥ 2. You can enter a single value or a series of values.

**R (Group Sample Size Ratio)**
*This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”*

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1}. \]

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this ratio are considered.

N2 is related to N1 by the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer ≥ Y.
For example, setting $R = 2.0$ results in a Group 2 sample size that is double the sample size in Group 1 (e.g., $N_1 = 10$ and $N_2 = 20$, or $N_1 = 50$ and $N_2 = 100$).

$R$ must be greater than 0. If $R < 1$, then $N_2$ will be less than $N_1$; if $R > 1$, then $N_2$ will be greater than $N_1$. You can enter a single or a series of values.

**Percent in Group 1**

*This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for $N_1$ and $N_2.”*

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for $N_1$ and $N_2$. Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

---

**Sample Size (When Not Solving for Sample Size)**

**Group Allocation**

Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are:

- **Equal ($N_1 = N_2$)**
  
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter $N_1$ and $N_2$ individually**
  
  This choice permits you to enter different values for $N_1$ and $N_2$.

- **Enter $N_1$ and $R$, where $N_2 = R \times N_1$**
  
  Choose this option to specify a value (or values) for $N_1$, and obtain $N_2$ as a ratio (multiple) of $N_1$.

- **Enter total sample size and percentage in Group 1**
  
  Choose this option to specify a value (or values) for the total sample size ($N$), obtain $N_1$ as a percentage of $N$, and then $N_2$ as $N - N_1$.

**Sample Size Per Group**

*This option is displayed only if Group Allocation = “Equal ($N_1 = N_2$).”*

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for $N_1$, and also the value for $N_2$.

The Sample Size Per Group must be $\geq 2$. You can enter a single value or a series of values.

**$N_1$ (Sample Size, Group 1)**

*This option is displayed if Group Allocation = “Enter $N_1$ and $N_2$ individually” or “Enter $N_1$ and $R$, where $N_2 = R \times N_1$.”*

$N_1$ is the number of items or individuals sampled from the Group 1 population.

$N_1$ must be $\geq 2$. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = "Enter N1 and N2 individually."

N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.

R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = "Enter N1 and R, where N2 = R * N1."

R is the ratio of N2 to N1. That is,

R = N2/N1

Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:

N2=[R x N1],

where the value [Y] is the next integer ≥ Y.

For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can enter a single value or a series of values.

Total Sample Size (N)
This option is displayed only if Group Allocation = "Enter total sample size and percentage in Group 1."

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.
You can enter a single value or a series of values.

Percent in Group 1
This option is displayed only if Group Allocation = "Enter total sample size and percentage in Group 1."

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

Effect Size

P1 (Proportion in Group 1)
Enter value(s) for the response proportion in the first group under both hypotheses and the response proportion of the second group under the null hypothesis of equal proportions. The values must be between zero and one.

You may enter a range of values such as 0.1, 0.2, 0.3 or 0.1 to 0.9 by 0.2.

P2 (Proportion in Group 2)
Enter value(s) for the response proportion of the second group under the alternative hypothesis. You may enter a range of values such as 0.1, 0.2, 0.3 or 0.1 to 0.9 by 0.2.
Look Details

This box contains the parameters associated with Group Sequential Design such as the type of spending function, the times, and so on.

Number of Looks

This is the number of interim analyses (including the final analysis). For example, a five here means that four interim analyses will be run in addition to the final analysis.

Boundary Truncation

You can truncate the boundary values at a specified value. For example, you might decide that no boundaries should be larger than 4.0. If you want to implement a boundary limit, enter the value here.

If you do not want a boundary limit, enter None here.

Spending Function

Specify which alpha spending function to use. The most popular is the O'Brien-Fleming boundary that makes early tests very conservative. Select User Specified if you want to enter your own set of boundaries.

Max Time

This is the total running time of the trial. It is used to convert the values in the Times box to fractions. The units (months or years) do not matter, as long as they are consistent with those entered in the Times box.

For example, suppose Max Time = 3 and Times = 1, 2, 3. Interim analyses would be assumed to have occurred at 0.33, 0.67, and 1.00.

Times

Enter a list of time values here at which the interim analyses will occur. These values are scaled according to the value of the Max Time option.

For example, suppose a 48-month trial calls for interim analyses at 12, 24, 36, and 48 months. You could set Max Time to 48 and enter 12,24,36,48 here or you could set Max Time to 1.0 and enter 0.25,0.50,0.75,1.00 here.

The number of times entered here must match the value of the Number of Looks.

- Equally Spaced

  If you are planning to conduct the interim analyses at equally spaced points in time, you can enter Equally Spaced and the program will generate the appropriate time values for you.

Informations

You can weight the interim analyses on the amount of information obtained at each time point rather than on actual calendar time. If you would like to do this, enter the information amounts here. Usually, these values are the sample sizes obtained up to the time of the analysis.

For example, you might enter 50, 76, 103, 150 to indicate that 50 individuals were included in the first interim analysis, 76 in the second, and so on.

Upper and Lower Boundaries (Spending = User)

If the Spending Function is set to User Supplied you can enter a set of lower test boundaries, one for each interim analysis. The lower boundaries should be negative and the upper boundaries should be positive. Typical entries are 4,3,3,3,2 and 4,3,2,2,2.

- Symmetric

  If you only want to enter the upper boundaries and have them copied with a change in sign to the lower boundaries, enter Symmetric for the lower boundaries.
Group-Sequential Tests for Two Proportions

Test

Alternative Hypothesis
Specify whether the test is one-sided or two-sided. When a two-sided hypothesis is selected, the value of alpha is halved. Everything else remains the same.

Note that the accepted procedure is to use Two-Sided unless you can justify using a one-sided test.

Continuity Correction
Specify whether to use the Continuity Correction. This option applies an adjustment to the sample sizes that is recommend by Fleiss(1981) page 45 to make the alpha and beta values more accurate. The formula for the adjustment is

\[
N_{1_{\text{new}}} = \frac{N_{1_{\text{old}}}}{4} \left( 1 + \sqrt{1 + \frac{2(R + 1)}{R(N_{1_{\text{old}}}(P_1 - P_2))}} \right)^2
\]

Options Tab
The Options tab controls the convergence of the various iterative algorithms used in the calculations.

Maximum Iterations

Maximum Iterations (Lan-Demets Algorithm)
This is the maximum number of iterations used in the Lan-DeMets algorithm during its search routine. We recommend a value of at least 200.

Tolerance

Probability Tolerance
During the calculation of the probabilities associated with a set of boundary values, probabilities less than this are assumed to be zero.

We suggest a value of 0.0000000001.

Power Tolerance
This is the convergence level for the search for the spending function values that achieve a certain power. Once the iteration changes are less than this amount, convergence is assumed. We suggest a value of 0.0000001.

If the search is too time consuming, you might try increasing this value.

Alpha Tolerance
This is the convergence level for the search for a given alpha value. Once the changes in the computed alpha value are less than this amount, convergence is assumed and iterations stop. We suggest a value of 0.0001.

This option is only used when you are searching for alpha.

If the search is too time consuming, you can try increasing this value.
Example 1 – Finding the Sample Size

A clinical trial is to be conducted over a two-year period to compare the proportion response of a new treatment to that of the current treatment. The current response proportion is 0.53. Although the researchers do not know the true proportion of patients that will survive with the new treatment, they would like to examine the power that is achieved if the proportion under the new treatment is 0.63. In order to compare the sample size requirements for different effect sizes, it is also of interest to compute the sample size at response rates of 0.60, 0.65, 0.70, and 0.75.

Testing will be done at the 0.05 significance level and the power should be set to 0.90. A total of four tests are going to be performed on the data as they are obtained. The O’Brien-Fleming boundaries will be used.

Find the necessary sample sizes and test boundaries assuming equal sample sizes per arm and two-sided hypothesis tests.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Group-Sequential Tests for Two Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Group-Sequential, and then clicking on Group-Sequential Tests for Two Proportions. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Continuity Correction</td>
<td>Checked</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>P1 (Proportion in Group 1)</td>
<td>0.53</td>
</tr>
<tr>
<td>P2 (Proportion in Group 2)</td>
<td>0.60 0.63 0.65 0.70 0.75</td>
</tr>
<tr>
<td>Number of Looks</td>
<td>4</td>
</tr>
<tr>
<td>Spending Function</td>
<td>O'Brien-Fleming</td>
</tr>
<tr>
<td>Boundary Truncation</td>
<td>None</td>
</tr>
<tr>
<td>Max Time</td>
<td>2</td>
</tr>
<tr>
<td>Times</td>
<td>Equally Spaced</td>
</tr>
<tr>
<td>Informations</td>
<td>Blank</td>
</tr>
</tbody>
</table>
Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>P1</th>
<th>P2</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.900168</td>
<td>1102</td>
<td>1102</td>
<td>2204</td>
<td>0.53</td>
<td>0.60</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.900930</td>
<td>542</td>
<td>542</td>
<td>1084</td>
<td>0.53</td>
<td>0.63</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.900408</td>
<td>376</td>
<td>376</td>
<td>752</td>
<td>0.53</td>
<td>0.65</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.901093</td>
<td>187</td>
<td>187</td>
<td>374</td>
<td>0.53</td>
<td>0.70</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.903126</td>
<td>111</td>
<td>111</td>
<td>222</td>
<td>0.53</td>
<td>0.75</td>
<td>0.050</td>
</tr>
</tbody>
</table>

Report Definitions

Target Power is the desired power value (or values) entered in the procedure. Power is the probability of rejecting a false null hypothesis.

Actual Power is the power obtained in this scenario. Because N1 and N2 are discrete, this value is often (slightly) larger than the target power.

N1 and N2 are the number of items sampled from each population.

N is the total sample size, N1 + N2.

P1 is the proportion of populations 1 and 2 under the null hypothesis of equality.

P2 is the proportion of population 2 at which power and sample size calculations are made.

Alpha is the probability of rejecting a true null hypothesis.

Summary Statements

Sample sizes of 1102 and 1102 achieve 90% power to detect a difference of 0.07 between the group proportions of 0.53 and 0.60 at a significance level (alpha) of 0.0500 using a two-sided z-test with continuity correction. These results assume that 4 sequential tests are made using the O'Brien-Fleming spending function to determine the test boundaries.

This report shows the values of each of the parameters, one scenario per row. Note that 542 participants in each arm of the study are required to meet the 90% power requirement when the proportion is 0.63.

The values from this table are in the chart below. Note that this plot actually occurs further down in the report.

Plots Section

This plot shows that a large increase in sample size is necessary when the detectable proportion in group two is less than 0.63.
**Details Section**

<table>
<thead>
<tr>
<th>Look</th>
<th>Time</th>
<th>Lower Bndry</th>
<th>Upper Bndry</th>
<th>Nominal Alpha</th>
<th>Inc Alpha</th>
<th>Total Alpha</th>
<th>Inc Power</th>
<th>Total Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.50</td>
<td>-4.33263</td>
<td>4.33263</td>
<td>0.000015</td>
<td>0.000015</td>
<td>0.000015</td>
<td>0.003525</td>
<td>0.003525</td>
</tr>
<tr>
<td>2</td>
<td>1.00</td>
<td>-2.96311</td>
<td>2.96311</td>
<td>0.003045</td>
<td>0.003036</td>
<td>0.003051</td>
<td>0.255573</td>
<td>0.259098</td>
</tr>
<tr>
<td>3</td>
<td>1.50</td>
<td>-2.35902</td>
<td>2.35902</td>
<td>0.018323</td>
<td>0.016248</td>
<td>0.019299</td>
<td>0.427801</td>
<td>0.686899</td>
</tr>
<tr>
<td>4</td>
<td>2.00</td>
<td>-2.01406</td>
<td>2.01406</td>
<td>0.044003</td>
<td>0.030701</td>
<td>0.050000</td>
<td>0.214031</td>
<td>0.900930</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3.27640</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Drift

This report shows information about the individual interim tests. One report is generated for each scenario.

**Look**
These are the sequence numbers of the interim tests.

**Time**
These are the time points at which the interim tests are conducted. Since the Max Time was set to 2 (for two years), these time values are in years. Hence, the first interim test is at half a year, the second at one year, and so on.

We could have set Max Time to 24 so that the time scale was in months.

**Lower and Upper Boundary**
These are the test boundaries. If the computed value of the test statistic $z$ is between these values, the trial should continue. Otherwise, the trial can be stopped.

**Nominal Alpha**
This is the value of alpha for these boundaries if they were used for a single, standalone, test. Hence, this is the significance level that must be found for this look in a standard statistical package that does not adjust for multiple looks.

**Inc Alpha**
This is the amount of alpha that is spent by this interim test. It is close to, but not equal to, the value of alpha that would be achieved if only a single test was conducted. For example, if we lookup the third value, 2.35902, in normal probability tables, we find that this corresponds to a (two-sided) alpha of 0.018323. However, the entry is 0.016248. The difference is due to the correction that must be made for multiple tests.

**Total Alpha**
This is the total amount of alpha that is used up to and including the current test.

**Inc Power**
These are the amounts that are added to the total power at each interim test. They are often called the exit probabilities because they give the probability that significance is found and the trial is stopped, given the alternative hypothesis.

**Total Power**
These are the cumulative power values. They are also the cumulative exit probabilities. That is, they are the probability that the trial is stopped at or before the corresponding time.

**Drift**
This is the value of the Brownian motion drift parameter.
Boundary Plots

This plot shows the interim boundaries for each look. This plot shows very dramatically that the results must be extremely significant at early looks, but that they are near the single test boundary (1.96 and -1.96) at the last look.
Example 2 – Finding the Power

Continuing the scenario began in Example1, the researcher wishes to calculate the power of the design at sample sizes 200, 400, 600, 800, 1000. Testing will be done at the 0.01, 0.05, 0.10 significance levels and the overall power will be set to 0.10. Find the power of these sample sizes and test boundaries assuming equal sample sizes per arm and two-sided hypothesis tests.

Proceeding as in Example1, we decide to translate the mean and standard deviation into a percent of mean scale.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Group-Sequential Tests for Two Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Group-Sequential, and then clicking on Group-Sequential Tests for Two Proportions. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Continuity Correction</td>
<td>Checked</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.01 0.05 0.10</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>200 to 1000 by 200</td>
</tr>
<tr>
<td>P1 (Proportion in Group 1)</td>
<td>0.53</td>
</tr>
<tr>
<td>P2 (Proportion in Group 2)</td>
<td>0.63</td>
</tr>
<tr>
<td>Number of Looks</td>
<td>4</td>
</tr>
<tr>
<td>Spending Function</td>
<td>O’Brien-Fleming</td>
</tr>
<tr>
<td>Boundary Truncation</td>
<td>None</td>
</tr>
<tr>
<td>Max Time</td>
<td>2</td>
</tr>
<tr>
<td>Times</td>
<td>Equally Spaced</td>
</tr>
<tr>
<td>Informations</td>
<td>Blank</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

<table>
<thead>
<tr>
<th>Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>P1</th>
<th>P2</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.254797</td>
<td>200</td>
<td>200</td>
<td>400</td>
<td>0.53</td>
<td>0.63</td>
<td>0.010</td>
</tr>
<tr>
<td>0.581920</td>
<td>400</td>
<td>400</td>
<td>800</td>
<td>0.53</td>
<td>0.63</td>
<td>0.010</td>
</tr>
<tr>
<td>0.805679</td>
<td>600</td>
<td>600</td>
<td>1200</td>
<td>0.53</td>
<td>0.63</td>
<td>0.010</td>
</tr>
<tr>
<td>0.920951</td>
<td>800</td>
<td>800</td>
<td>1600</td>
<td>0.53</td>
<td>0.63</td>
<td>0.010</td>
</tr>
<tr>
<td>0.970898</td>
<td>1000</td>
<td>1000</td>
<td>2000</td>
<td>0.53</td>
<td>0.63</td>
<td>0.010</td>
</tr>
<tr>
<td>0.478378</td>
<td>200</td>
<td>200</td>
<td>400</td>
<td>0.53</td>
<td>0.63</td>
<td>0.050</td>
</tr>
<tr>
<td>0.790815</td>
<td>400</td>
<td>400</td>
<td>800</td>
<td>0.53</td>
<td>0.63</td>
<td>0.050</td>
</tr>
<tr>
<td>0.928267</td>
<td>600</td>
<td>600</td>
<td>1200</td>
<td>0.53</td>
<td>0.63</td>
<td>0.050</td>
</tr>
<tr>
<td>0.977859</td>
<td>800</td>
<td>800</td>
<td>1600</td>
<td>0.53</td>
<td>0.63</td>
<td>0.050</td>
</tr>
<tr>
<td>0.993673</td>
<td>1000</td>
<td>1000</td>
<td>2000</td>
<td>0.53</td>
<td>0.63</td>
<td>0.050</td>
</tr>
<tr>
<td>0.599827</td>
<td>200</td>
<td>200</td>
<td>400</td>
<td>0.53</td>
<td>0.63</td>
<td>0.100</td>
</tr>
<tr>
<td>0.867330</td>
<td>400</td>
<td>400</td>
<td>800</td>
<td>0.53</td>
<td>0.63</td>
<td>0.100</td>
</tr>
<tr>
<td>0.961331</td>
<td>600</td>
<td>600</td>
<td>1200</td>
<td>0.53</td>
<td>0.63</td>
<td>0.100</td>
</tr>
<tr>
<td>0.989659</td>
<td>800</td>
<td>800</td>
<td>1600</td>
<td>0.53</td>
<td>0.63</td>
<td>0.100</td>
</tr>
<tr>
<td>0.997396</td>
<td>1000</td>
<td>1000</td>
<td>2000</td>
<td>0.53</td>
<td>0.63</td>
<td>0.100</td>
</tr>
</tbody>
</table>
These data show the power for various sample sizes and alphas. It is interesting to note that once the sample size is greater than 700, the value of alpha makes little difference on the value of power.
Example 3 – Effect of Number of Looks

Continuing with examples one and two, it is interesting to determine the impact of the number of looks on power. PASS allows only one value for the Number of Looks parameter per run, so it will be necessary to run several analyses. To conduct this study, set alpha to 0.05, N1 to 500, and leave the other parameters as before. Run the analysis with Number of Looks equal to 1, 2, 3, 4, 6, 8, 10, and 20. Record the power for each run.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Group-Sequential Tests for Two Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Group-Sequential, and then clicking on Group-Sequential Tests for Two Proportions. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
Design Tab | 
Solve For | Power
Alternative Hypothesis | Two-Sided
Continuity Correction | Not checked
Alpha | 0.05
Group Allocation | Equal (N1 = N2)
Sample Size Per Group | 500
P1 (Proportion in Group 1) | 0.53
P2 (Proportion in Group 2) | 0.63
Number of Looks | 1 (Also run with 2, 3, 4, 6, 8, 10, and 20)
Spending Function | O’Brien-Fleming
Boundary Truncation | None
Max Time | 2
Times | Equally Spaced
Informations | Blank

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

| Numeric Results for Two-Sided Test of Proportions |
|---|---|---|---|---|---|---|---|
| Power | N1 | N2 | N | P1 | P2 | Alpha | Looks |
| 0.893174 | 500 | 500 | 1000 | 0.53 | 0.63 | 0.050 | 1 |
| 0.892118 | 500 | 500 | 1000 | 0.53 | 0.63 | 0.050 | 2 |
| 0.889620 | 500 | 500 | 1000 | 0.53 | 0.63 | 0.050 | 3 |
| 0.887691 | 500 | 500 | 1000 | 0.53 | 0.63 | 0.050 | 4 |
| 0.885125 | 500 | 500 | 1000 | 0.53 | 0.63 | 0.050 | 6 |
| 0.883535 | 500 | 500 | 1000 | 0.53 | 0.63 | 0.050 | 8 |
| 0.882456 | 500 | 500 | 1000 | 0.53 | 0.63 | 0.050 | 10 |
| 0.879929 | 500 | 500 | 1000 | 0.53 | 0.63 | 0.050 | 20 |

This analysis shows how little the number of looks impacts the power of the design. The power of a study with no interim looks is 0.893174. When twenty interim looks are made, the power falls to 0.879929—a very small change.
Example 4 – Studying a Boundary Set

Continuing with the previous examples, suppose that you are presented with a set of boundaries and want to find the quality of the design (as measured by alpha and power). This is easy to do with PASS. Suppose that the analysis is to be run with five interim looks at equally spaced time points. The upper boundaries to be studied are 3.5, 3.5, 3.0, 2.5, 2.0. The lower boundaries are symmetric. The analysis would be run as follows.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Group-Sequential Tests for Two Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Group-Sequential, and then clicking on Group-Sequential Tests for Two Proportions. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
Design Tab | Power
Solve For | Two-Sided
Alpha | 0.05 (will be calculated from boundaries)
Group Allocation | Equal (N1 = N2)
Sample Size Per Group | 500
P1 (Proportion in Group 1) | 0.53
P2 (Proportion in Group 2) | 0.63
Number of Looks | 5
Spending Function | User Supplied
Boundary Truncation | None
Max Time | 2
Times | Equally Spaced
Informations | Blank
Upper Boundaries | 3.5 3.5 3.0 2.5 2.0
Lower Boundaries | Symmetric

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>P1</th>
<th>P2</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.887792</td>
<td>500</td>
<td>500</td>
<td>1000</td>
<td>0.53</td>
<td>0.63</td>
<td>0.048157</td>
</tr>
</tbody>
</table>

Details when Spending = User Supplied, N1 = 500, N2 = 500, P1 = 0.53, P2 = 0.63

<table>
<thead>
<tr>
<th>Look</th>
<th>Time</th>
<th>Lower Bound</th>
<th>Upper Bound</th>
<th>Nominal Alpha</th>
<th>Inc Alpha</th>
<th>Total Power</th>
<th>Inc Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.40</td>
<td>-3.50000</td>
<td>3.50000</td>
<td>0.000465</td>
<td>0.000465</td>
<td>0.000465</td>
<td>0.019352</td>
</tr>
<tr>
<td>2</td>
<td>0.80</td>
<td>-3.50000</td>
<td>3.50000</td>
<td>0.000465</td>
<td>0.000465</td>
<td>0.000465</td>
<td>0.019352</td>
</tr>
<tr>
<td>3</td>
<td>1.20</td>
<td>-3.00000</td>
<td>3.00000</td>
<td>0.002700</td>
<td>0.002410</td>
<td>0.005110</td>
<td>0.058108</td>
</tr>
<tr>
<td>4</td>
<td>1.60</td>
<td>-2.50000</td>
<td>2.50000</td>
<td>0.012419</td>
<td>0.010331</td>
<td>0.022750</td>
<td>0.039341</td>
</tr>
<tr>
<td>5</td>
<td>2.00</td>
<td>-2.00000</td>
<td>2.00000</td>
<td>0.045500</td>
<td>0.034542</td>
<td>0.080042</td>
<td>0.240425</td>
</tr>
<tr>
<td>Drift</td>
<td>3.20355</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The power for this design is about 0.89. This value depends on both the boundaries and the sample size. The alpha level is about 0.048. This value only depends on the boundaries.

Example 5 – Validation using O’Brien-Fleming Boundaries

Reboussin (1992) presents an example for binomial distributed data for a design with two-sided O’Brien-Fleming boundaries, looks = 5, alpha = 0.05, beta = 0.10, P1 = 0.1100, P2 = 0.0825. They compute a drift of 3.28 and a sample size of 2381.78 per group. The upper boundaries are: 4.8769, 3.3569, 2.6803, 2.2898, 2.0310.

To test that PASS provides the same result, enter the following.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Group-Sequential Tests for Two Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Group-Sequential, and then clicking on Group-Sequential Tests for Two Proportions. You may then make the appropriate entries as listed below, or open Example 5 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Continuity Correction</td>
<td>Not checked</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>P1 (Proportion in Group 1)</td>
<td>0.1100</td>
</tr>
<tr>
<td>P2 (Proportion in Group 2)</td>
<td>0.0825</td>
</tr>
<tr>
<td>Number of Looks</td>
<td>5</td>
</tr>
<tr>
<td>Spending Function</td>
<td>O’Brien-Fleming</td>
</tr>
<tr>
<td>Boundary Truncation</td>
<td>None</td>
</tr>
<tr>
<td>Max Time</td>
<td>1</td>
</tr>
<tr>
<td>Times</td>
<td>Equally Spaced</td>
</tr>
<tr>
<td>Informations</td>
<td>Blank</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Target</th>
<th>Actual</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>P1</th>
<th>P2</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>Power</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90</td>
<td>0.90011</td>
<td>2474</td>
<td>2474</td>
<td>4948</td>
<td>0.1100</td>
<td>0.0825</td>
<td>0.050000</td>
</tr>
</tbody>
</table>

Details when Spending = O'Brien-Fleming, N1 = 2468, N2 = 2468, P1 = 0.1100, P2 = 0.0825

<table>
<thead>
<tr>
<th>Look</th>
<th>Time</th>
<th>Lower Bndry</th>
<th>Upper Bndry</th>
<th>Nominal Alpha</th>
<th>Inc Alpha</th>
<th>Total Alpha</th>
<th>Inc Power</th>
<th>Total Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.20</td>
<td>-4.87688</td>
<td>4.87688</td>
<td>0.000001</td>
<td>0.00001</td>
<td>0.000001</td>
<td>0.000324</td>
<td>0.000324</td>
</tr>
<tr>
<td>2</td>
<td>0.40</td>
<td>-3.35695</td>
<td>3.35695</td>
<td>0.000788</td>
<td>0.000787</td>
<td>0.000788</td>
<td>0.099454</td>
<td>0.099778</td>
</tr>
<tr>
<td>3</td>
<td>0.60</td>
<td>-2.68026</td>
<td>2.68026</td>
<td>0.007357</td>
<td>0.006828</td>
<td>0.006828</td>
<td>0.346699</td>
<td>0.446477</td>
</tr>
<tr>
<td>4</td>
<td>0.80</td>
<td>-2.28979</td>
<td>2.28979</td>
<td>0.022034</td>
<td>0.016807</td>
<td>0.024424</td>
<td>0.299644</td>
<td>0.746120</td>
</tr>
<tr>
<td>5</td>
<td>1.00</td>
<td>-2.03100</td>
<td>2.03100</td>
<td>0.042255</td>
<td>0.025576</td>
<td>0.050000</td>
<td>0.153985</td>
<td>0.900105</td>
</tr>
</tbody>
</table>

Drift 3.27939

The difference in the sample sizes (2474 versus 2382) is due to rounding errors in the Reboussin article. Reboussin rounds from four-digits to three-digits, which caused a large difference. **PASS** uses more accurate routines.

To see that the results are equal to within rounding error, we will compute the sample size using Reboussin’s results, but with more decimal places in the intermediate steps. They had

\[
 n_K = \frac{2(0.096)(0.904)(3.28)^2}{(0.028)^2} = 2381.78
\]

When we compute this without rounding, we get

\[
 n_K = \frac{2(0.09625)(0.90375)(3.27939)^2}{(0.0275)^2} = 2474.00
\]

A sample size of 2474 is the result obtained in PASS.